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Elections Next Month 
In April, the group will once again 

1 take to the polls to determine who our 
fearless leaders will be. See Rick's 
View From the Top for the President's 
views on his past term and what his 
successor can look forward to. 

Novice SIG Notes 

by Don Baird 

Solving the conflicting elements of 
a Novice SIG (special interest group) 

1 is challenging. This piece addresses 
1 the cyclic interest in such groups and 

how to avoid their demise when the 
interest wanes to the extent that a 
group might die before interest 
reinstates. This writer feels it impor­
tant to have continuous novice SIG 
activity, because persons entering the 
computer arena often have no way to 
efficiently gain conversance. Joining a 

cosmopolitan computer group can 
solve part of the problem but it is 
tantamount to having a kinder­
gartner enter the eighth grade, espe­
cially if the main group has no novice 
SIG. 

A Novice SIG with more adap­
tability may have more chance to sur­
vive. One way of doing this could be: 
To relax rigid novice meeting 
schedules when attendance is low and 
unpredictable, and have meetings 
more random to match the incidental 
number expressing interest. This re­
quires a constant rallying point exist­
ing even during a dearth of interest. 
Times, places, and agenda could be 
tailored according to the persons in­
volved when triggered by enough 
phone requests to a rally-person. 

An on-going roster is key to this 
operation and serves to connect people 
with like interests (and problems). 
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Such a roster already exists. It can 
enable the means of organizing people 
towards the formulation of im­
promptu meetings. 

To avoid a rally-volunteer from 
being unduly burdened, a delegating 
procedure could be thus: When even 
only one call is received, the rally-per­
son provides the caller with the cur­
rent roster. The caller can choose who 
to notify from interest information on 
the roster, and from guidance from the 
rally- person. This serves to make the 
first caller, the titular organizer of a 
meeting. Further calls received by the 
rally- person, can be referred to the 
first caller, who can delegate more 
calling and other duties necessary to 
a successful meeting. 

Decisions on time, place, and agen­
da can suit those involved in the 
process. During a meeting, future 
times, etc. can be set rigidly or allowed 
to again be triggered randomly as 
before. There are innumerable 
aspects to having broad spectra meet­
ings typical of novice sig meetings. For 
example, a club membership should 
have a number of mentor-type per­
sons to chose from who are willing to 
lead these random novice meetings, if 
requested. Not all meetings need a 
guru, but that can be decided by a late 
consensus, usually because many ex­
perienced computer users don't mind 
coming on short notice. 

To get something going, I can 
volunteer as rally-person to whom 
calls can be directed. I would then 
send out a packet of rosters to anyone 
wishing to formulate an impromptu 
meeting or series of meetings. This 
scheme should induce more in-

This Month 
OS/2 Redux Redux 

This time we promise: IBM 
will be on hand to show us OS/2. 
After a series of scheduling 
hurdles, we will indeed be visited 
by one of the engineers who has 
been closely involved with the 
new operating system since it.s 
birth. 

Come see what you're already 
missing. 

Program of the Month 
This is also a recording ... Vice­

President Corwin Nichols will 
take another stab at 4DOS, re­
placement/enhancement shell for 
standard DOS. 

So you see, you have your 
choice: you can either buy OS/2 
and do away with DOS al­
together, or you can check out 
4DOS and do away with just a 
portion of DOS. 

Isn't this great-a PC user 
group that tells you nothing ex­
cept how to do away with the 
operating system ... 

The disk will be available for 
$1 or you may use your Goodie 
Coupon. 

dividual participation with an ac­
celeration in learning the basics and 
then moving to advanced subjects. ~ 
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Uncle SPAUG 
Wants You! 

by Rick Altman, 
Club President 

Once again, that time approaches 
for our club: the time to elect 

new leaders. I always look upon this 
time with both exhiliration and fear. 

On the one hand, I like change, and 
I think that change for the sake of 
change is often a good thing. I'm one 
of those guys who usually likes when 
the manager of a baseball team gets 
fired-it often lights a spark under the 
players. It's an excuse to be optimistic, 
and any reason to see the cup as half­
full is okay in my book. 

On the other hand, I know the 
hist.ory of this group, and let's just say 
that volunteerism is not its strongest 
suit. We frequently have to pull a few 

teeth in order t.o develop a slate of 
candidates. 

I swung back and forth in the last 
few weeks, and this article will come 
as a surprise to a few, but I will not be 
seeking a second term as President. 
Change is not only good for the club; 
it's good for me, too, and right now, I 
need to melt into the background a bit, 
and turn the reins over to someone 
else. 

Ah, yes-but who? My biggest fear 
is that I will stand up in front of the 
membership this month, ask for 
nominations, and be met with silence. 
Indeed, what if no one wants to run for 
President of the group? Does that 
mean that it dies? Can it run itself? 
Will the members of the Steering 
Committee take turns? Will anybody 
even notice the difference? 

These are not rhet.orical questions, 
and they are not meant to be sarcastic. 
These are the very real questions that 
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My biggest fear is that no one will run for 
President. What if no one wants to be 

President of the club? Does that mean that it 
dies? Can it run itself? Will someone 

magically emerge? 
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we must face, in lieu of nominations 
made and accepted by worthy can­
didates. 

And what makes a worthy can­
didate? Being President is a blast­
this group has proved over and over 
again to be one of the most receptive 
audiences to new ideas. Worthiness is 
measured by willingness, and a 
modicum of responsibility. You in­
stantly become more connect.ed in the 
software industry than 95 percent of 
all computer users, and free software 
is usually but a phone call away (yes, 
you should plan on sharing your dis­
coveries about your new toys with the 
group, but software manufacturers 
never ask for their programs back). 

What are the myths of the 
Presidency? The first is that you have 
to be some computer hot-shot-that's 
totally false. You only have to know 
where the hot-shots sit in the 
auditorium, and usually they sit in the 
same place each month. 

The second is that you have to be a 

professional speaker or lecturer. The 
only requirement is that you not 
pretend to be one, because no one in 
the group wants the President trying 
to be someone that he or she isn't. The 
monthly agenda is very simple, and 
for the most part, it runs itself. There 
are always plenty of people willing to 
demonstrate the programs of the 
month, and the main speakers come 
with their own agendas. A quiet and 
well-organized President could 
probably preside over the entire eve­
ning in 200 words or less. 

Now for the requirements. Your 
monthly obligations will 

increase by one evening, as the 
mid-month planning meeting is 
important for you to attend. It consists 
of coffee, cookies, and ideas, in an 
order of your own choosing. 

Your most important duty is to line 
up speakers, and I don't mean 

- see next page 

What are the myths of the Presidency? The 
first is that you have to be some computer 

hot-shot-that's totally false. You only have 
to know who the hot shots are and where 

they sit in the auditorium. 
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Our Next Presidency 

from previous page 

celebrities. Sure, we'd take Bill Gates, 
but some of our very best meetings 
have featured anonymous repairmen, 

1 undistinguished musicians, strug­
gling entrepreneurs, and other plain 
folk like you and me. On numerous 

1 occasions, the guest speakers have 
been you and me. 

Again, the mid-month planning 
1 meeting is a great resource for plan­

ning guest speakers. In fact, several 
presidents have delegated the entire 
job t.o a vice-president or an ad-hoc 
committee, and as long as the job gets 
done, that's perfectly acceptable. 

The number one requirement is 
merely a willingness to become 

involved, and that brings us full-circle: 
we just don't have enough 
involvement from the general 
membership. I really don't want to lay 
guilt trips on anyone-this is a club, 
not your occupation- but as a 

volunteer organization, there is a 
minimum amount of volunteerism 
that is required. We hover perilously 
at or just below that point. If we are a 
club of only observers, our days might 
be numbered. 

Being President is fun and easy­
so much so that for awhile I believed 
that I could do it again, even in the face 
of overwhelming demands on my time 
and energy. Also, don't discount the 
inevitable fact that just by running, 
you will become a hero to us all. 

And this call for action extends 
beyond the Presidency. Becoming 
more involved in the planning of this 
group's future is also fun and easy, 
and you need not hold official office in 
order to make lasting impressions on 
our prosperity. 

SPAUG is looking for a few good 
men and women, and I'll bet you could 
both name one and be one. If you want 
to save me from standing before you 
in silence during our upcoming call for 
nominations, you'll do just that. 11 

111 Jliiiiiiiliiiiiilillrn I ~ W:OI Iii = 

As President, you instantly become more 
connected in the software industry than 95 

percent of all computer users-and free 
software is usually but a phone call away. 
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Get the new Hardcard rr·M 
at a special low price for 

user group members only. 

$649 for the Hardcard II SON 
$549 for the Hardcard II 40™ 

The new Hardcard II is the most 
convenient way to add 80 or 40 
MB of high-performance mass 
storage capacity to your 286 or 
386 system. Its 19 ms effective 
access time and high reliability 
(60,000-hour Mean Tune Between 
Failure) meet the demands of 
high performance systems and 
disk-intensive applications. And 
at one inch thin, it occupies any 
single 16-bit slot. 

You can install it yourself in under 
30 minutes, and ifs backed by a 
full two-year warranty. Just what 
you'd expect from Plus, makers of 
the original Hardcard®. 

Place your order or ask for more 
information now! 

Call 1-800-624-5545, and ask 
for ext. 520. Have your mem­
bership number ready. All major 
credit cards accepted. 

Ojfrr limited to one Hardcard II prr member, and is good tlirnugh May 31, 1990. 
Membership number must be provided at time of order. 

) HC-PCI .) 



Is Do-Everything 
Software For You? 

1 by Rebecca Bridges Altman 

This article is an excerpt from 
Becky's book, Mastering Microsoft 
Works for the IBM PC, published by 
Sybex Books. The book will 'be avail­
able in June, 1990. 

M icrosoft Works is an all-in-one 
package containing four 

distinct tools: word processor, 
spreadsheet, database, and 
communications. Let's look at each of 
these tools in more detail. 

With the word processor tool you 
can create and revise letters, memos, 
and long reports and docwnents. This 
tool takes the place of your typewriter. 

You will use the spreadsheet tool 
to do financial planning, analysis, 
budgets, projections, and forecasts. It 
takes the place of accounting ledger 
paper, pencil, calculator, and a big 
eraser. You can also use the spread­
sheet tool to graph your data. 

The database tool allows you to 
keep track of information, such as 
client records or a mailing list. You 
can search, sort, and create reports. 

8 + PRinTS ·n, March 1990 

An Overview of 
Microsoft Works 

The database tool takes the place of 
your filing cabinet or Rolodex. 

With the fourth tool, communica­
tions, you can transfer information 
between two computers over the 
telephone lines. You can send some­
one a budget or a report, or you can 
connect to a service such as Home­
Banking. You might say that the com­
munications tool takes the place of the 
post office and other delivery services. 

Because all four tools are con­
tained in one package, you can easily 
transfer information between dif­
ferent types of files. Here are several 
examples of how you can transfer in­
formation between different types of 
files in Works: 

• You can copy a spreadsheet into a 
word processing document. 

• You can create a graph in the 
spreadsheet tool of stock prices 
you received from an on-line stock 
information service in the com­
munications tool. 

• You can print personalized letters 
in the word processor tool to 
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everyone who is on your mailing 
list in the database tool. 
Another advantage to an all-in-one 

package is that you don't have to learn 
several different programs. If you 
weren't using Works, you would have 
to purchase four different programs to 
get the same power: a word processing 
program, . a spreadsheet program, a 
database program, and a communica­
tions program. Because these pack­
ages are separat.e and not related to 
one another, each program operat.es 
differently. But with Works, the 
menus and commands are consist.ent 
from tool to tool. 

Mouse vs. Keyboard 
Microsoft Works can be used with 

just your keyboard or with a combina­
tion of a mouse and a keyboard. A 
mouse is a device that has several 
buttons on top (the mouse's ears, sup­
posedly) and is connect.eel to your com­
puter with a thin cable (the mouse's 
tail). By moving the mouse on your 
desktop, you move a pointer on your 
screen. You use the buttons (primarily 
the left one) to perform tasks such as 
selecting text, scrolling the screen, 
and choosing menu commands. 

You don't have to have a mouse to 
use Works. However, some com­
mands are fast.er or more convenient 
with the mouse. If you haven't used a 
keyboard much or you are competing 
for World's Worst Typist, you will 
enjoy using this little critt.er. But don't 
over-use the mouse--sometimes it 
makes more sense to perform a task 
from the keyboard. After using 
Microsoft Works for awhile, you will 

discover which tasks work better with 
a mouse or with a keyboard. 

How to Use the Menus 
When you first start the Works 

program, you see the screen shown in 
Figure 1. The 1nenu bar across the t.op 
of the screen displays three main op­
tions: File, Options, and Help. The 
File pull-down menu is aut.omatically 
displayed for you as well. The pull­
down menu displays commands on a 
vertical list. 

This screen display is similar t.o a 
restaurant menu. The main options 
on the Works menu (File, Options, 
Help) correspond to the food 
categories on a restaurant menu (Ap­
petizers, Salads, Entrees, Desserts). 
The choices on a pull-down menu 
(Create New File, Open Existing File, 
Save, etc.) correspond to the specific 
dishes (Cherries Jubilee, Baked Alas­
ka, Mud Pie, etc.) listed in a food 
cat.egory. 

The Works menu is different than 
a restaurant menu in that you can't 
see all dishes at once. On a restaurant 
menu you usually have a two-page 
spread where you can see all the ap­
petizers, salads, and entrees. In 
Works, you can only see one "food 
category" (pull-down menu) at a time. 
For example, right now you can only 
see the "dishes" in the File menu. If 
you press Right Arrow, you can see the 
choices in the Options menu. Press 
Right Arrow again, and you can see 
what's cooking in the Help menu. 
Press Right Arrow one more time and 
you are back t.o the File menu. 

-see next page 
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Microsoft Works 

from previous page 

Press the Esc (Escape) key now t.o 
move out of the File pull-down menu. 
The menu bar is still visible, but none 
of the pull-down menus are available 
right now. 

Working with Files 
And Windows 

As shown in Figure 1, the File 
menu lists all the actions you would 
want t.o perform on your files: creat;e, 
open, save, and close. When you 
choose the Create a New File option, 
you are asked t.o choose the type of file: 
Word Processor, Spreadsheet, 
Database, or Communications. Notice 
that these file types correspond t.o the 
four Works tools. You then see a blank 
screen int.o which you can create the 
type of file you specified. You don't 
name a file until you choose the File 
Save or File Save As command. 

Saving is an extremely important 
part of using a com-
puter. The letters, 
reports, graphs, 
and tables you cre­
ate in Microsoft 
Works are in the 
computer's tem­
porary memory. 
Until you give your 
Save command, 
the file is not per-
manently recorded 
on your hard disk 
or floppy disk. If 
the power goes off 
before you save, 

ii••-- ,.,...,,. ...... 'fl • ••• 
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you will lose precious work. 
Therefore, you will use the Save AB 

command to assign a new name t.o 
your file, or the Save command when 
you have already named a file and 
want t.o save it with the same name. 

To recall a file you have already 
saved, you use the Open Existing File 
command. When you finish working 
with a file, use the Close command. If 
you have made any changes since you 
last saved, Works asks you if you want 
t.o save your changes-you neednl 
worry about accidentally closing a file 
you haven't saved. 

One of the more powerful aspects 
of Works is that you can have more 
than one file open at a time. Each file 
is stored and displayed in its own win­
dow. A window is simply a bordered 
container for a file. You don't need to 
go through any special steps to open 
multiple files. If you have a file on your 
screen when you open an existing file 
or when you create a new file, the first 
file is placed in a window behind the 
second one. ~ 
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It's That Time Again ... 

by Wayne Wilson, 
Utah PCUG 

I t was a real non-decision when the 
upgrade offer for the current 

version of TurboTax from ChipSoft 
arrived in the mail. I have used 
previous releases in preparing my 
Federal Income Tax Return for the 
past two years. It is hard for me to 
imagine plowing through piles of 
paper and government gobbledygook 
withou t TurboTax or a similar 
package. 

TurboTax is basically an income 
tax preparation aid. It supports over 
50 forms, schedules, and worksheets, 
and provides depreciation and amor­
tization schedules. The package is 

well- suited to both simple returns and 
the self-employed taxpayer who has 
many forms and schedules. 
Throughout the program, screens 
function like an overlaid spreadsheet 
that allows the user to enter informa­
tion into the appropriate cells. 

First time users can use an Auto· 
Interview feature that will determine 
and report the necessary forms for 
each individual situation. The process 
of filing is intuitive and straight for­
ward. The first step is filling out the 
Personal Information section. This in­
cludes demographic information that 
the program will automatically carry 
over to all forms and schedules. Pre­
vious users can import data from the 
past year and not have to enter any 
information that has not changed. 

- see next page 

It was a non-decision when the upgrade 
offer for the current version of Turbo Tax 

from ChipSoft arrived in the mail. It is hard 
for me to imagine plowing through piles of 

paper and government gobbledygook 
without TurboTax. 
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Potpourri 

from previous page 

This form also shows income and tax 
information from previous years so it 
is easy to see how the so-ealled tax 
reforms continue to cost individuals 
more and more every year. 

Next is a W-4 screen for input of 
wages and withholding information. 
Previous users will enjoy finding 
employer's names and information al­
ready in place; only the current num­
bers need to be entered. At this point 
individual situations dictate the next 
action. For a "short form," using 
standard deductions, the return is 
ready to print. Others need to supply 
information to the appropriate forms. 
One feature that I enjoy is the ability 
to see the infamous ''bottom line" 
whenever I want to. By invoking the 
Tax Window a summary showing 
basic figures, including amount of tax 
owed, can be viewed at any time. You 

can see your refund shrink or grow as 
you enter information. 

The final step is printing the 
return. TurboTax supports many dot 
matrix and laser printers. It also has 
a method to edit printer setup codes 
for customizing to individual printers 
not specifically supported in a format 
acceptable to the IRS. 

Previous users ofTurboTax will be 
interested in new features and enhan­
cements added this year. The instal­
lation program has been greatly 
improved. Hard disk installation can 
be done from either disk drive and 
include a full path statement. It is no 
longer necessary to delete an options 
file and rename the hard disk options 
file as in past years. Also new this year 
is a pull-down menu system that 
matches an emerging standard in pro­
gram operation. The program retains 
the familiar "f' menu access. This year 
there is also full mouse support built 
in. An interesting feature is the func­
tion of the right niouse button. Press-

TurboTax supports many dot matrix and 
laser printers. It also has a method to edit 

printer setup codes for customizing to 
individual printers not specifically 

supported in a format acceptable to the IRS. 
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ing it will cause the cursor to move 
continuously in the direction it was 
last moved until the button is pressed 
again. This allows for visually review­
ing a form at a convenient rate (at 
least on my 12 Mhz system). Some of 
you with fast 386's may not find this 
feature useful. 

IBM Laser Announced 

Redwood PCUG 

As anticipated, IBM announced a 
laser printer that's aimed at stealing 
some of Hewlett Packard's thunder. 
The 4019 Laser Printer is essentially 
a LaserJet II knockoff that is faster, 
smaller, and less expensive. Besides 
H-P II emulation, IBM's product also 
offers HPGL plotter emulation. The 
4019 does accept downloadable H-P 
fonts, but does not use H-P font 
cartridges. Instead, it uses credit card­
sized font cartridges. At 10-pages per 
minute, the IBM laser printer is 2 
pages per minute faster than the H-P 
while selling for $100 less. A Post­
Script upgrade will be available by 
mid-1990. Expect H-P to respond with 
a vengeance. 

A Remote Deal 

Redwood PCUG 

You say you've always wanted to 
buy "remote computing" but just 
couldn't justify the expense? Here's 
your chance: EKD is offering every­
thing you need to get into "remote 
control" for only $399, retail price. The 
combination of software and 
hardware would normally sell for 
$733. Here's the deal: you get pc-

Anywhere III software, a 2400 baud 
modem, and a device to turn your 
computer on from afar, for less than 
$400! Who knows, discounts may 
drive the price down to $300. 

The software, pcAnywhere, is a 
package that lets you operate your 
computer at work, from your home, as 
if you were sitting in the office at the 
keyboard. Of course, you'll need a 
computer with a modem at home, also. 
This type of software is often used to· 
provide assistance over the phone 
lines. For instance, you could change 
a batch file (or demonstrate a proce­
dure) in a remote office, without 
having to go there or send disks. EKD 
is the distributor of pcAnywhere. For 
information, call them at (516) 736-
0500. 

Listing Today's Files 

by Becky Altman 

I am one of those rare people who 
religiously backs up her files every 
day. I only back up the files that have 
changed on the current date. Because 
I got tired of scanning the directory for 
files with today's date, I created a 
batch file. This batch file lists only the 
files with today's date. The batch file, 
named L.BAT, is listed below: 

echo off 
els 
dir >dir.txt 
find "% 111 dir.txt 
del dir.txt 

To run this batch file, type L fol­
lowed by today's date. For example, to 
list the files modified on March 18, you 
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would type L 3-18. The format of your 
date is important; you need to enter 
the date in the same format as ap­
pears in the DOS directory. You do not 
need a zero before single-digit months, 
but you do need the zero before single­
digit days. For example, to enter 
March 5, you would type 3-05. 

Here is an explanation of how the 
batch file works. After turning off the 
screen echo and clearing the screen, 
this batch file sends a copy of the 
current directory to a file named 
DIR.TXT. Then the batchfilesearches 
the DIR.TXT file for each occurrence 
of the date you typed as the variable 
%1, and displays the line on the 
screen. After the list of files is dis-

I only back up the 
files that have 
changed on the 
current date. 

Because I got tired 
of scanning the 

directory for files 
with today's date, 
I created a batch 
file that lists only 

the files with 
today's date. 
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played, the batch file deletes 
DIR.TXT. 

Once the list is displayed, I know 
which files I need to back up. Because 
DIR.TXT was created on today's date, 
it also appears on the list; this file 
should be ignored. I use the following 
batch file to speed up copying each file: 

copy %1 .* a: 

I named this batch file C.BAT. 
When I want to back up a file to drive 
A, I type C followed by the first name 
of the file. For example to back up the 
file named Fl G 1-1. CAP, all I need to 
type is C FIGl-1. 

d i r.txt 

APPB WPS 4420 3-19-90 

A.PPA WPS 23416 3-19-90 
APPC WPS 40542 3-19-90 

APPD WPS 25446 3-19- 90 

Hayes Gets Reasonable 

Redwood PCUG 

10 : 0 7a 
l O:OOa 
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In an att.empt to recapture market 
share, Hayes Microcomputer 
Products, Inc., has slashed the prices 
of its modem line, up to 43%. Hayes 
has always been perceived as having 
high quality products , but at a 
premium price. As more and more 
users buy modems, that perception 
has caused Hayes to lose many sales. 

Hayes-compatible modems often 
sell for one-third the price of Hayes 
products. The new pricing brings 
Hayes' products more in line with the 
market place, and means more folks 
may get "the real thing." ~ 



The SPAUG Resource Center 

Club Officers 

President Rick Altman 962-9270 
Vice President Corwin Nichols 494-8640 
Treasurer/ASSU Rep Jared Nedzel 854-2732 

Managers 

Financial Manager Beverly Altman 329-8252 
Newsletter Editor Becky Altman 326-8605 
Production Editor Rick Altman 962-9270 

Library 

Public Domain Software Les Weil 321-5541 

Software 

Accounting-Computer Assoc. Larry Mehl 326-6037 
Foxbase Marie Hooper 325-1206 
Framework Jim Caldwell 692-7181 

Richard Orser 408-425-04 7 4 
Word/Word for Windows Jan Altman 408-243-5955 
Microsoft Works Becky Altman 962-9270 
R:BASE Larry Mehl 326-6037 
Symphony Sally See 941-1378 

Languages/Operating Systems 
t c Corwin Nichols 494-8640 

Fortran, Pascal John Watson 325-7632 
Epson Printers Jim Caldwell 692-7181 

) PRinT screen, ~, h 1990 • 15 



The Stanford I Palo Alto· 

P.O. Box 3738, 
Stanford, CA 94309 

Club Information 

Membership Louise Greer Bolitho 
322-3850 
$25/year fee (Students $1 0) 

Bulletin Board 424-0812 
Newsletter Becky Altman 

326-8605 
P.O. Box982 
Palo Alto, CA 94302 

'~ 
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